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Valentine’s Day: 2.14

One legend has it that Valentine’s Day
originated to commemorate the anniver-
sary of the death of St. Valentine, a
Roman clergyman who was executed on
Feb. 14, about 270 A.D., for secretly
marrying couples in defiance of the

Computer News

Route emails to mailbox
From Wired
Two of the world’s biggest e-mail
account providers, Yahoo and America
Online, plan to introduce a service that
would charge senders a fee to route their
e-mail directly to a user’s mailbox with-
out first passing through junk mail fil-
ters, representatives of both companies
said Sunday.

The fees, which would range from
1/4 cent to 1 cent per e-mail, are the lat-
est attempts by the companies to weed
out unsolicited ads and identity-theft
scams. In exchange for paying, e-mail
senders will be guaranteed their mes-
sages won’t be filtered and will bear a
seal alerting recipients they’re legiti-
mate.
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emperor. According to another, the holi-
day began as a Roman fertility festival.
Americans probably began exchanging
handmade valentines in the early 1700s.
In the 1840s, Esther Howland, a native
of Massachusetts, began to sell the
nation’s first mass-produced valentine
cards.

Sixty-five percent of the nation’s
households which purchase a greeting
card for Valentine’s Day, making this act
the top way to celebrate this observance.
Other popular ways to celebrate include
“date night” (44 percent) and giving
candy (38 percent), flowers (32 percent),
gift cards (29 percent), plush (i.e.,
stuffed toys) (21 percent),
perfume/cologne (12 percent), jewelry
(11 percent) and other gifts (17 percent).
(Source: Hallmark)

Digest

The plan, while it’s optional and
would apply to only a fraction of people
sending e-mail, amounts to a reversal in
the economics of the internet because it
would charge message senders rather
than those receiving them. The current
model has led to the proliferation of
spam and so-called phishing scams
because the people perpetuating them
can turn a profit even when only a
minority of recipients respond.

AOL and Yahoo said the program,
which is being offered through a compa-
ny called Goodmail Systems, will target
banks, online retailers and other groups
that send large amounts of e-mail. In
exchange for a payment and a pledge to
contact only people who have agreed to
receive their messages, the companies
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Reprint. Unless otherwise indicated,
articles may be reprinted in other non-profit
publications without express permission,
subject to the following conditions. Full
acknowledgement must be given to the
MPCUG, The Bridge, and the author. The
article must be reproduced in its entirety
from magnetic media, without editorial
changes, deletions or additions. Two copies
of the entire publication containing the
reprinted article should be sent to The
Bridge within 30 days of publication. All
other rights reserved. Any changes to the
article require the written permission of the
author. All articles are made available
through the APCUG BBS and on disk to
qualified non-profit organizations.
Any opinions expressed belong to the
author and not the Memphis PC Users
Group, Inc. Articles in this newsletter may
contain trademarks of various companies.
Any proprietary right those companies
have in those names is hereby
acknowledged.
Submission. Unless otherwise indicated, all
submissions to this newsletter become the
property of Memphis PC Users Group,
Inc., and are subject to editing by the staff.
The MPCUG reserves the right to determine
the suitability for publication of all items
received. Members are encouraged to submit
articles for publication. By submitting
articles, the author gives permission for
publication in this newsletter and for
publication by other user groups. The editor
cannot guarantee that all submissions will
be used.
Information Usage. The information con-
tained in this newsletter is believed to be cor-
rect and
accurate; however, the Memphis PC Users
Group, Inc., cannot and will not assume
responsibility for the consequences or errors
contained in articles or misapplication of
any information provided. Any information
used from these articles is at the user's own
risk. If a review of any hardware or
software contains errors or inaccuracies,
upon notification of these errors or
inaccuracies by the manufacturer in writing,
a correction will be printed in the
subsequent issue following receipt of these
corrections. The Memphis PC Users Group,
Inc.,makes no warranty, expressed or implied,
as to the suitability of any advertised
product. You must determine that yourself.
The Memphis PC Users Group, Inc., also
expressly declines to assume liability for
any use of any published software, and
your use of same constitutes your
agreement to hold us blameless.
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would be ensured their e-mails aren’t
diverted to spam folders or have
images or web addresses filtered out.
Browsing for Browsers

From PC magazine

But what should you look for in a
browser? That depends on your priori-
ties. Most people use Internet Explorer
6, which lets them view ActiveX
pages. ActiveX page makes the Web
more interactive, but ActiveX support
can also be used as a back door for
spyware. Firefox and Opera don’t sup-
port ActiveX, so they miss out on
some functionality, but it makes for
safer browsing. Netscape sidesteps the
issue by offering both Firefox’s and
IE’s rendering engines, so you can run
ActiveX when you need to.

Firefox In the space of a roughly a
year, Firefox has gone from relative
obscurity to being the second most
popular browser in the world. And the
recent 1.5 update makes the nimble
browser even better. Firefox is slim
but full-featured, and a lot of the fea-
tures in IE7 clearly take their cues
from the open-source browser.
Internet Explorer Love it or hate it,
IE commands somewhere around 80
percent of the market. IE6 is becom-
ing quite long in the tooth, however,
and lacks some of the convenient fea-
tures included in the other browsers.
Internet Explorer 7 (beta) The first
beta version of IE7 isn’t intended—or
ready—for the masses, so we don’t
recommend downloading it quite yet
unless you’re a developer. We’re glad
to (finally) see tabbed browsing in IE,
and the integrated RSS reader, smooth
printing and zooming, and redesigned
interfaces are all welcome changes.
Netscape Netscape is more than just a
browser; it’s an information platform.
We love useful features like the
Multibar and the ability to choose
between two rendering engines. The
user interface can be cluttered and

confusing, but overall, Netscape is a
solid choice. Opera Opera 8.0 is a
very capable browser that was first to
market with some unique features,
such as rearrangement of tabs and
page zooming, and the next version of
Opera will even include integrated
BitTorrent support. Overall, it has a
host of attractive and innovative fea-
tures that make browsing easier.
Information Security

From Computerworld

An apparent attempt to recycle dis-
carded internal reports has ended up in
the compromise of credit card and
bank number information belonging to
more than 240,000 subscribers of The
Boston Globe and the Worcester
Telegram & Gazette.

The snafu occurred when the
account information of Globe and
T&G subscribers who pay for their
home delivery subscriptions by credit
card was disclosed on the back of
more than 9,000 individual routing
slips used to label bundles of the
Worcester Sunday Telegram, the
Globe said in a statement today. The
bank routing information of some
T&G subscribers who do not pay by
credit card may have also been inad-
vertently disclosed, the paper said.
Web Site Lets Public Track
Alaska Volcano
From Associate Press
From his home in Nanwalek, Vince
Evans can stare across the water at
Augustine Volcano as it pumps out
clouds of ash and steam, but Evans
prefers to check the Internet for the
latest on the erupting island mount.
The Alaska Volcano Observatory's
popular Web site lets the public track
Augustine's activity, from live earth-
quake data to hourly updates on the
blasts of ash and rocky pyroclastic
flows that have rumbled down the
snowy volcano since it began erupting
in mid-January.
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Fortify Our Computers:RootkitRevealer

By Gil Hennon

Once upon a time there were only viruses, Trojans,
and worms. One decent anti-virus utility could protect your
PC from all three at a modest price and without much fuss
and bother. Then came broadband Internet connections,
and firewalls became necessities lest hackers invade your
files. Most of us use both a hardware and software fire-
wall, and the price of PC security is a lot higher. Next we
were slammed by spybots and adware, requiring some-
times several different utilities to catch and kill all those
pesky critters. Do you believe that your anti-virus, anti-
spyware, and firewall protection has you safely covered?
Don’t bet on it!

With the recent exposure of the Sony BMG, Symantec,
and Kaspersky rootkit type infections, now another piece
needs to be added to the security arsenal-a rootkit snif-
fer—because without one, you’ll never know that a rootkit
is in control of your PC.

I recently tested Mark Russinovich’s RootkitRevealer.
It is a powerful program that uncloaks all hidden directo-
ries and files on all hard drives while being very easy to
use. The default settings, the way it runs without any
tweaks, works fine and is all that most users will need.

Security Program

There is no installation: Just unzip and run the executable
program file. For really picky folks, there are a few set-
tings that can be changed for very special circumstances.

RootkitRevealer reports any directory or file on the PC
that was not visible to all operating system functions.
Some files will be invisible to one or two functions occa-
sionally, but when all three can’t see it, there is probably a
rootkit doing some cloaking inside the system.
RootkitRevealer does not remove rootkits when they are
found-it only reports them. At that point, the best course of
action is to go to Mark’s SyslInternals forum and identify
what was found, then get an uninstaller from the rootkit
creator’s Web site. Manual removal of a rootkit can be a
very tricky procedure, and a mistake can render a PC inop-
erative. If an uninstaller is not available, a complete system
reload is usually the best fix.

The SyslInternals Web site has a download link at
http://www.sysinternals.com/Utilities/RootkitRevealer.html
and detailed instructions on the utility’s use. There are
sample screens of results and explanations of any messages
you might receive. Best of all, RootkitRevealer is freeware.
It won’t raise the cost of maintaining a secure PC.

Microsoft Office Word Power Keys

Working with text

* To add a check box to a document, point to Toolbars on the
View menu, click Forms, and then click Check Box Form
Field on the Forms toolbar.

* To return to the location of the last edit, press SHIFT+F5.

*To look up synonyms in the thesaurus, select a word and
press SHIFT+F7.

* To restore selected text to its original formatting, press
CTRL+SPACEBAR.

* To sort dates, numbers, and other text in ascending or
descending order, click Sort on the Table menu.

* To edit in print preview, click Magnifier on the Print
Preview toolbar.

* To hyphenate a document automatically, click Language on
the Tools menu, and then click Hyphenation.

* To select a rectangular block of text, press ALT and drag.

* To turn overtype mode on or off, double-click OVR on the
status bar.

Tricks & Tips

* To insert symbols and other special characters, click
Symbol on the Insert menu.

* To count the number of words in a document or selection,
click Word Count on the Tools menu.

Automatic text options

* To turn on AutoFormat for creating lines: In Word 2003
and Word 2002, click AutoCorrect Options on the
Tools menu, click the AutoFormat As You Type tab,
and then select the Border lines check box. In Word
2000, click AutoCorrect on the Tools menu, click the
AutoFormat As You Type tab, and then select the
Borders check box.

* To create a line, press and hold the hyphen key to make
at least three hyphens, and then press ENTER. To cre-
ate a thicker line, hold the SHIFT key down at the
same time, making at least three underlines before
pressing ENTER.
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Microsoft Money 2006 Premium part

By Rick Fischer

e don’t normally run multi-part reviews. | think
Wthis is a worthy exception. 1’ve used Quicken

for years. The head-to-head reviews in maga-
zines usually suggest it is a tossup between Money and
Quicken. I wanted to find out for myself. So, follow me as
I set up Money 2006 Premium in this part. This is the kind
of program that you’d want to test drive for a while.

Getting Started

Money 2006 ships with a CD and a brochure that tells you
what all comes with your version. No manual in the box. |
looked on the CD. No printable file there. The brochure
tells me to see the Users Guide under the Help menu. |
click. I find that I must be online to view it.

After connecting to the Internet, I can view the Users
Guide. It is all online. No option to print it as a unit and
take it with me. I can print individual pages and | can cut
and paste the content of each page into Word, but it looks
very big. | confess | copied and pasted one chapter so far.
Also, | ordered a copy of Microsoft Money 2006 for
Dummies from Amazon. There are only two book choices
there. | saw no books on Money 2006 on the Microsoft
Press site. That probably means it’s an easy program. Easy
is one thing, but | want to form a mental model of what |
can do with Money before | start.

A big reason vendors encourage reviews is to see how
end users use their products. So I’ll confess — | want to
read about the program before | get started. So, my prefer-
ence would be a manual I can hold. Note to Microsoft: If
you are not going to package a manual anymore, include
the Users Guide in a pdf file that | can print. Then let me
just sit, read, highlight and make notes in the margins
indicating how | will use my new program. | understand a
little better why O’Reilly calls one series: “The Missing
Manual.”

The program load went well. It took all my Quicken
data and imported it into Money. If you skip that part dur-
ing setup, you can come back later and convert your
Quicken file. My Dummies book tells me that several
things do not come across: memorized charts, transaction
passwords, category groups and savings goals. My
expense categories did come over, so this must be another
kind of category they are talking about.

I did not use online banking services in Quicken, but
my Dummies book tells me that | would have to cancel

Book Review

my Quicken online servic-
es and reapply for those
same services under
Money.

When you open
Money 2006 it asks for a
username and password,
or your Microsoft
Passport Network user-
name and password.
According to my
Dummies book you can
override the request, but |
missed the override and
provided my Passport information. Money presumes you
will want to work online. But, you also have the option to
work offline.

Browser look and feel

The first thing | noticed when | opened Money 2006 was
the relaxing soft blue colors around the screen. Then |
noticed that the program itself was made to look and
behave like a browser. There is a home page that you will
want to customize (see Figure 1). As in your browser,
click on what you want and use forward and back arrows
to move around. Yes, there are dropdown menus.

In fact, the designers of the Money interface clearly want-
ed you to use this program while connected to the
Internet. Remember how the Users Guide was only avail-
able online? Your interaction with the Money Website is
seamless. | set up downloads for financial news which are
updated when | go online. And, | can update the prices of
my mutual funds. There’s a window to enter Web address-
es in Money. You will view them inside Money.

Setting up accounts
I see all my old accounts. But they all could use a little
tweaking. Now is the time to change the names of some of
my accounts. | can use long names in Money and | take
advantage of that feature right away. Each account has set-
tings so that | can easily click “Settings” and see my
account number, interest paid, and how to contact my
bank or other institution. | take the time to fill in as much
as | can.

I find I have some accounts that are no longer active
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and there are some | never
entered into Quicken. To delete
an account, you just select the ==
account and click delete. To i

add an account — well, there = —

are a number of ways to do

that depending on whether you = —

are connected to the Internetof = ~——

not. -
| followed the recommen-

dation of the Dummies book

and set up my accounts first. |

want to try online banking, so T

at some point | will go back s

and enter the information I will

need to access and update my

accounts. All my financial institutions have arrangements

with Microsoft to help me make the connection.

Working with accounts

Let’s start with checking accounts. You will have two
ways to enter transactions. One, you can enter information
in a form that includes the date, check number, amount,
payee and category. You have to enable this by checking
the box called *“show transaction forms.” Two, you can
enter the same data directly into the register much like
you do in Quicken.

I received my bank balance at the start of the month.
Time to balance my checking account.

Although the entries that had previously cleared going
back to 1992 (from Quicken) show that they are recon-
ciled on the register, when | tried to balance my account
they all showed as unreconciled on the balance screen.
That created a problem that | am still trying to sort out. |
didn’t like any of the options Money offered me for han-
dling the difference. | don’t believe this would be a prob-
lem if you were starting fresh.

For now | do not intend to track credit card purchases,
but I could if I wanted to. Since | pay them off each
month anyway, | am trading off recording categories for
my purchases — useful at tax time.

Odds and ends
Microsoft has a quarterly eNewsletter for Money users.
Sign up at the Microsoft Money Website (see below).
They used to be archived on the site, but for some reason
have been removed. | am waiting for my first copy.

My box tells me that I get free stuff worth $249 when

I purchase Money
12006 Premium. From
Experian | can get one
credit report and one
year’s worth of credit
monitoring. From
GainsKeeper | get free
one year of capital
gains tracking. |
access GainsKeeper
through Money 2006
and can use their
what-if tools.
Microsoft included a
copy of H&R Block’s
DeductionPro. This is
great for tracking donations of non-cash items. We have
used it for several years. The built-in database suggests
the fair market value of items you enter. That means you
will want to update it from time to time to update the val-
ues database. Moonjar provides educational materials for
kids about handling money. You can go to their Website
and sign up for a free cardboard money box package.
Finally, there is a discount coupon should you want to
purchase checks and forms to use with Money.

So the accounts are set, but not refined. There’s more
to learn and enable. Let’s get used to using Money 2006
Premium. | plan to sign up for online banking. Part 2 will
let you know how it went. And, there are still planning
tools to explore. If you would like to know more, here is
the reference site: http://www.microsoft.com/money

Record from IT Helpdesk

Computer Humor

Helpdesk: What kind of computer do you have?
Customer: A white one...

Customer: Hi, this is Celine. | can't get my diskette out.
Helpdesk: Have you tried pushing the button?
Customer: Yes, sure, it's really stuck.

Helpdesk: That doesn't sound good; I'll make a note."
Customer: No. Wait a minute. | hadn't inserted it yet. It's
still on my desk. Sorry.

Tk Kok Fok Kok ok ko kok Aok Kok ok ok Kok Kok Kok Kok ok

Helpdesk: Click on the 'my computer' icon on the left of
the screen.
Customer: Your left or my left?
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he Sony’s Rootkit Tale: A Follow-up

By Gil Hennon

he hullabaloo over Sony BMG
I music CDs installing a rootkit

on customer PCs died down
during January. The company settled
a major legal action by promising to
exchange infected CDs for clean
ones. The deal includes offering a
tool to remove the rootkit, a free
music download, and a small cash
remuneration for the customer’s trou- )
ble. That settled a New York lawsuit.
With fourteen more suits on the
dockets, and expecting more to
come, Sony BMG hopes that its
quick agreement in the New York
court will influence the rest to
accept a similar deal.

Although Sony BMG publicly
apologized for violating the privacy and security of their
customers’ PCs, the company is still mum about how
many computers their rootkit actually infected.
Considering that at least 52 music CD titles containing the
rootkit were released since March of 2005, and that more
than a half-million Internet Domain Name Servers cached
the address that the rootkit used to “phone home,” esti-
mates of several million PC infections are probably rea-
sonable.

As word of the Sony BMG rootkit spread during
November and December of last year, and the public
learned what to look for, reports of infections have includ-
ed not only individual music customer PCs, but also mis-
sion critical computers in businesses, governmental
offices, and military installations all around the world.
Sony BMG probably never considered the legal and pub-
lic relations fallout that would result from its creative
scheme for protecting its copyrights, and initially appeared
completely unaware of the serious computer security vul-
nerability inherent in a rootkit installation. Hopefully, it is
now a wiser and more cautious company.

Besides promising to clean up all of the PCs infected
by its eXtended Copy Protection (XCP) rootkit, Sony
BMG has also agreed to quit collecting personal informa-
tion from MediaMax, its previous copy protection scheme.
MediaMax got a more thorough examination by security
specialists after the XCP rootkit brought suspicion on the
entire line of music CDs, and MediaMax has been found

5
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SONYABMG

The cool “Sony CD with Teeth” image used in
this article is from Collapsibletank at
http://www.jimcromwell.com/landfill/sonybmg-

Computer Security

to contain some security holes
and vulnerabilities of its own.
Sony BMG has a legal right to
protect its property.
Unfortunately, the methods it
chose for doing that have been
insecure, abusive, and very
probably illegal. There are also
still unanswered questions about
how well the company is fulfill-
ing its repentant promises.

One serious concern of
many security administrators is
whether infected customers are
actually downloading and
installing the fixes that Sony
BMG agreed to provide. There
is now a link on the Sony Home
page to the instructions and downloads, but for a while
they were buried deep in the site and were somewhat diffi-
cult to find. There does not seem to be any program going
on at Sony to contact customers and guide them to the
fixes—nothing like the mechanism that the automobile
industry uses for recalls. The rootkit was briefly men-
tioned in articles in a few major newspapers. Usually the
piece ran in the business sections, where the financial
implications and stock prices get more attention than any
boring technical details. Only PC users who read comput-
er magazines or technical forums on the Internet are likely
to understand the security implications of a rootkit instal-
lation and the risks it poses. What percentage of Sony CD
customers fall into this group? No one knows! Probably
the only customers getting the fixes are those who know
enough to fear the rootkit.

I checked a music loving friend’s PC with Rootkit
Revealer and found that he was infected. | gave him the
URL for the Sony BMG fixes. Several weeks have gone
by and he still has not bothered to get the repair utility.
His PC is running okay and he can’t see the security
holes. His PC is still exposed to hackers. He is also lax
about getting patches and updates. What scares me is that
he is not at all unusual. | believe the majority of infected
PC owners are just like him.

No one knows how many infected CDs have been
returned to Sony BMG either, but it’s a pretty good bet
that a lot of them are still around. Even a few would be
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enough to keep reinfecting PCs for
years. Those who write malware pro-
grams that exploit the Sony BMG
rootkit’s back door are counting on
PC user apathy to provide a rich and
ongoing environment for mischief
and profit. Without an expensive and
time consuming hunt to eradicate all
instances of the rootkit installations
and the infectious CDs, nearly every
business, government, and military network remains vul-
nerable to hackers. Sony BMG says that they manufactured
4.7 million infected CDs and that about 2.1 million were
sold. The remainder are supposed to be removed from the
store shelves. But who is keeping count to make sure that
all of these infected CDs are destroyed and no longer
infecting any PCs?

Another very troubling result of the Sony BMG rootkit
scandal is the growing erosion of consumer faith in the
companies whose products they buy. Public protests and
citizen protection groups in many countries are fed up with
media companies that don’t mind abusing the rights of
consumers while protecting their profits. A popular petition
in Great Britain is calling for Parliament to pass more laws
insuring consumer rights, and citizens of other nations are
considering similar governmental controls. The behavior of
recording and movie industry companies in treating their
customers like pirates has not been fair or impartial, but
both sides of the issue should be very scared of handing
control of a market over to government regulators. Can’t
we ever learn from our past mistakes?

Even with all of these unanswered questions and unre-
solved issues, the Sony BMG rootkit eventually became
old news and only gets an occasional mention anymore.
The hot news these days is coming out of other companies
as they also own up to using rootkit or similar technologies
in their software. Mark Russinovich, who first discovered
the Sony BMG rootkit last year, exposed another commer-
cial software rootkit installation early this January. His
Rootkit Revealer utility found cloaking software guarding
the Norton Protected Recycle Bin in Symantec’s
SystemWorks software. Symantec admitted that the cloak-
ing function was added to the software during the 1990s,
but claimed that it did not fit the definition of a rootkit
because it was not installed with malicious intent.
Russinovich and other security professionals disagree.
Symantec, they contend. cannot justify using rootkit tech-
nology even for a good purpose. By hiding the existence of
files and directories from the operating system, Symantec

created a nest where any number of malicious programs
could exist without being detected by the user or scanned
by anti-virus and anti-spyware utilities. Whether well-
intentioned or not, the installation of this kind of software
results in a PC owner no longer in control of his/her pri-
vate property.

A few days later, other security investigators reported
that Kaspersky Labs, another anti-virus software manufac-
turer, uses rootkit-like cloaking techniques to hide files
used in scanning functions. Mark Russinovich has also
gone public in his Sysinternals BLOG about the increased
use of rootkit technology in commercial software.

On January 10, Symantec issued a patch that disables
the rootkit cloaking feature in the recycle bin of its
SystemWorks and SystemWorks Premier products.
Increased hacker awareness of rootkits and how they can
be used to compromise PC security changed Symantec’s
corporate mind about the wisdom of using this technology
in their products. The Moscow headquarters of Kaspersky
Labs is said to be considering a similar action. Very likely
the company will not be willing to sacrifice its excellent
reputation to retain a software feature that can be accom-
plished in another, less risky manner.

Neither Symantec nor Kaspersky’s rootkit cloaking
device was as dangerous as the Sony BMG rootkit. The
former were carefully written to perform only as intended
and were considered to be “bug free.” Not so with Sony’s
code, which had several security exposure holes as well as
a function to “phone home” with information about the PC
and its users. But regardless of whether or not a rootkit is
well written and reasonably well behaved, it still poses a
serious threat to any PC.

Eventually the rootkits that have been exposed will no
longer be active. Operating systems and applications
change, as well as hardware. Many old viruses hung
around for several years until they could no longer find a
system that they knew how to infect. So it will be with
today’s rootkits. Over the long run, there is a different con-
cern. Bruce Sterling put it quite well in his article “The
Rootkit of All Evil” in the February 2006 issue of Wired
Magazine. “The real issue is the blurring of lines between
blackhat hacking and legitimate business. It’s one thing
when Russian gangsters take over a few million computers
to shake down online casinos. It’s another when commer-
cial enterprises adopt the same methods to protect their
market. At that point, good corporate citizenship devolves
into vigilantism and the implicit trust between supplier and
customer unravels.”
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Make Your Own Halloween Mask in Minutes

By Katherine Murray

Halloween masks as everyone else. Or in just min-
utes you can make an original mask that will wow
the Halloween crowd.

Imagine the perplexed looks of the neighborhood chil-
dren when they come to the door and see you wearing a
mask of your child’s face. Or, for a last-minute costume,
you can go as your spouse or your pet. The possibilities
are endless.

To begin, you’ll need a good [
close-up photo of a face; a person | &
or a pet. Some other things you’ll |
need: L
* Microsoft Windows XP il
* An image editing program or : .-

image library program with a Y,
cropping tool

* A photo printer

* Photo printing paper (the thickest-or heaviest stock-that
your printer can use)

* A paint stirring stick or strips of wide ribbon

Capture your photo

Here are some tips to keep in mind when you’re shooting
the photo for your mask:

* Check your lighting: Whether you take the photo
indoors or outdoors, be sure that your subject’s face is
well-lit, with no deep shadows.

* Get close: Move in as close as possible, so your sub-
ject’s face fills the screen. You can use your camera’s
zoom feature, but you’ll get a better photo by shooting
close up and using less zoom.

* Give them a clue: Prompt your subject with, “Look
scary!” or, “Make the funniest face you can!” to get the
expression you want for your mask.

* Make it up: You can add makeup to create Halloween
scars, whiskers, funny moustaches, or other embellish-
ments before you take your picture.

* Take several shots: Shoot four or five images so you can
choose the best one for your mask.

* Add special effects: Use your image-editing program to
add special or funny touches to your photo. Add dra-
matic colors, eye patches, glasses, scars, facial hair, or
whatever strikes your fancy.

Crop the image

The next steps outline how to crop the photo to ensure

that your mask looks right.

S ure, you could go to the store and buy the same

©2004 Microsoft Corporation. All rights reserved.

From Microsoft

1. Select the cropping tool in your digital image editor or
image library program and select only the face. Get in
tight around the perimeter of the face, eliminating as much
of the background as possible.

2. Crop the image and save a
copy with a new name. An easy
way to remember what file is
your mask image is to add the
word “mask” to the end of the
file name so it’s easy to find.

If you are adding any special
effects with your digital image editor, add those artistic
touches now before you print the mask.

Print the mask

The Photo Printing Wizard in Windows XP will print a
photo that is large enough for a mask. Make sure to use
thick-or heavy stock-photo paper so your mask is durable.
1. Open the folder in which you saved your cropped
image.

2. Click Print pictures under Picture Tasks.

3. In the Photo Printing Wizard, click Next.

4. Click to select the photo you want to print by making
sure that the box in the corner of the photo has a check
mark in it. Be sure that other photos in your folder do not
have a check mark in their corner boxes.

5. Click Next.
6. Select a printer and then click Next.
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Make Your Own Halloween Mask in
Minutes continued

7. In Available layouts, under Full Page Prints, click to
select Full page photo print.
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8. Click Next to print your mask image.

Let the photo dry thoroughly before assembling the

mask.

Assemble the mask

Assembling the mask starts with cutting out the mask.

With sharp scissors, carefully cut around the perimeter of

the face.

You can assemble your mask in two different ways:

* If you are going to wear the mask, cut holes for the
eyes and mouth. Punch a hole on each side of the
mask and reinforce the holes with masking tape and
small pieces of cardboard for added durability. Now
tie a piece of ribbon to each hole. Use the ribbon to tie
the mask around your head.

* If you want to carry the mask, just cut holes for the
eyes and then glue the mask to a paint stir stick or
strip of balsa wood so that you can hold it in front of
your face. This is a good option for greeting trick-or-
treaters because you don’t have to wear it around the

house all

evening.

You’re done!

In just a few

minutes, you

made a per-
sonalized
mask that will

at least get a

few shrieks of

laughter on

Halloween.
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Meeting-in-a Box Works Well

Meeting Report

Members and guests who attended the January 2006 meet-
ing were transported to the 2005 Photoshop World Boston
exposition. The DVD video captured much of the excite-
ment of the show along with some wonderful Photoshop
CS pointers from experts who also write books for Peachpit
Press.

Rick Fischer introduced Peachpit’s Meeting-in-a-Box
and John Schuster handled the actual presentation. Peachpit
even included a bag of popcorn and candy for sharing.
Between bites members discussed Photoshop capabilities
and what was legally and ethically appropriate when han-
dling images.

The DVD contained a series of training seminars that
were conducted during the exposition. The presenters were
well-known Photoshop experts. The focus of the techniques
seemed to be the Curves tool and how it can correct over-
or underexposed details of a photograph. Several of the
experts provided some detail in how to use the Curves tool
and the effect it can have in the final image.

Another presenter demonstrated the Curves tool on a
Camera Raw image. This, of course, required that the
Camera Raw plug-in be present. The emphasis was that
making the adjustments in the Camera Raw environment
was equally as effective as on JPEG or TIFF images.
Following the DVD the group discussed the differences
between Photoshop and Photoshop Editor’s note-
Elements. Members benefited from ‘
having Larry Hunt as a guest for the
evening. He was able to field
image/graphics questions and pro-
vide a context for that was shown.

Thanks to Larry
Hunt and Rick
Fischer for contribut-
ing to this summary.

Photo Works Using
Photoshops

Photo Display

_= By Joey Greenwood
for Desktop Journal-
ism class at the
University of Mem-
phis in 2004
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Out for Review

10

Here is a list of software, books, or other products you can expect to see reviewed here in

the coming months. These members checked out items to review for the benefit of all.

Windows Me: The Missing Manual
Teach Yourself GoLive 5 in 24 Hours
Excel 2003 Personal Trainer
Photoshop CS2 One on One

TIVO Hacks

Home Theater Hacks

Windows XP in a Snap

Windows Security Handbook

Smart Home Hacks

The Little Web Cam Book

Microsoft Works 7.0

How to Use Microsoft FrontPage 2002
The Complete Idiot’s Guide to Starting A Business Online

Greg Adams
Allison Banks
Rob Bertling
Bill Brody
Jacob Burke
sborne Burks
Vicki Dabney
Dorothy Drum
Megan Hefner
Mike Heinrich
Jim Ingram
David Levine
David Levine

User Interface in C#

Photoshop Restoration & Retouching
Windows XP Pro (book)

Surviving a PC Disaster

Create Your Own Website

Macromedia (book)
Windows XP (book)

Photoshop Retouching Cookbook
Create Your Own Digital Photography

Jim McGee
Vanessa Muldrow
Daniel Notowitz
John Schuster
Jesse Strauch
David Stowell
Terry Thomas

Jin Yang

Qihong Zhou

Thanks to all who checked out products for review. Let’s keep the Group vital and pro-

vide value for membership.

For Your Information

Do you know how many PC user
groups in Tennessee are listed under
the Microsoft Mindshare web Site?
East Tennessee Computer Society
Knoxville, TN
Security
Personal productivity
General interest/hobbyist/home use
Entertainment & games
http://www.etcs.org/
Mid-Tenn Computer Group
Murfreesboro, TN
Personal productivity
Hardware
General interest/hobbyist/home use

Entertainment & games
http://mywebpages.comcast.net/m
tcg/index.htm
Philadelphia HUB PC User Group
Clarksville, TN
Personal productivity
Hardware
General interest/hobbyist/home use
Digital Photography
http://member.apcug.org/phlhubp
cug
Plateau PC Users Group
Crossville, TN
Personal productivity
Hardware
General interest/hobbyist/home
use

http://www.ppcuginc.com
Tri-Cities Macintosh Users Group
Johnson City, TN
Personal productivity
http://www.tccc.org
Tellico Village Computer Users
Club (TVCUC)
Loudon, TN
E-Commerce
Knowledge management
Security
Personal productivity
Hardware
General interest/hobbyist/home use
Entertainment & games
http://www.tvcuc.org



